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Introduction
The Microsoft Office Specialist (MOS) certification program has been designed to 
validate your knowledge of and ability to use programs in the Microsoft Office 2016 suite 
of programs. This book has been designed to guide you in studying the types of tasks 
you are likely to be required to demonstrate in Exam 77-727: Microsoft Excel 2016.

See Also  For information about the tasks you are likely to be required to demonstrate in Exam 
77-728: Microsoft Excel 2016 Expert, see MOS 2016 Study Guide for Microsoft Excel Expert by 
Paul McFedries (Microsoft Press, 2017).

Who this book is for
MOS 2016 Study Guide for Microsoft Excel is designed for experienced computer users 
seeking Microsoft Office Specialist certification in Excel 2016.

MOS exams for individual programs are practical rather than theoretical. You must 
demonstrate that you can complete certain tasks or projects rather than simply 
answer questions about program features. The successful MOS certification candidate 
will have at least six months of experience using all aspects of the application on a 
regular basis; for example, using Excel at work or school to create and manage work-
books and worksheets, modify and format cell content, summarize and organize data, 
present data in tables and charts, perform data operations by using functions and 
formulas, and insert and format objects on worksheets.

As a certification candidate, you probably have a lot of experience with the program 
you want to become certified in. Many of the procedures described in this book will 
be familiar to you; others might not be. Read through each study section and ensure 
that you are familiar with the procedures, concepts, and tools discussed. In some 
cases, images depict the tools you will use to perform procedures related to the skill 
set. Study the images and ensure that you are familiar with the options available for 
each tool.
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How this book is organized
The exam coverage is divided into chapters representing broad skill sets that correlate 
to the functional groups covered by the exam. Each chapter is divided into sections 
addressing groups of related skills that correlate to the exam objectives. Each section 
includes review information, generic procedures, and practice tasks you can complete 
on your own while studying. We provide practice files you can use to work through 
the practice tasks, and results files you can use to check your work. You can practice 
the generic procedures in this book by using the practice files supplied or by using 
your own files.

Throughout this book, you will find Exam Strategy tips that present information about 
the scope of study that is necessary to ensure that you achieve mastery of a skill set 
and are successful in your certification effort.

Download the practice files
Before you can complete the practice tasks in this book, you need to copy the book’s 
practice files and results files to your computer. Download the compressed (zipped) 
folder from the following page, and extract the files from it to a folder (such as your 
Documents folder) on your computer:

https://aka.ms/MOSExcel2016/downloads

IMPORTANT  The Excel 2016 program is not available from this website. You should purchase 
and install that program before using this book.

You will save the completed versions of practice files that you modify while working 
through the practice tasks in this book. If you later want to repeat the practice tasks, 
you can download the original practice files again.

The following table lists the practice files provided for this book.

https://www.aka.ms/MOSExcel2016/downloads
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Folder and objective group Practice files Result files

MOSExcel2016\Objective1
Create and manage worksheets 
and workbooks

Excel_1-1.xlsx
 
 
 
 
Excel_1-2.xlsx
Excel_1-3.xlsx
Excel_1-4.xlsx
Excel_1-5.xlsx

Excel_1-1_Results subfolder:
■■ Excel_1-1_results.xlsx
■■ MyBlank_results.xlsx
■■ MyCalc_results.xlsx

Excel_1-2_results.xlsx
Excel_1-3_results.xlsx
Excel_1-4_results.xlsx
Excel_1-5_Results subfolder:

■■ Excel_1-5a_results.xlsx
■■ MOS-Compatible.xls
■■ MOS-Template.xltm

MOSExcel2016\Objective2
Manage data cells and ranges

Excel_2-1.xlsx 
Excel_2-2.xlsx
Excel_2-3.xlsx

Excel_2-1_results.xlsx
Excel_2-2_results.xlsx
Excel_2-3_results.xlsx

MOSExcel2016\Objective3
Create tables

Excel_3-1.xlsx
Excel_3-2.xlsx
Excel_3-3.xlsx

Excel_3-1_results.xlsx
Excel_3-2_results.xlsx
Excel_3-3_results.xlsx

MOSExcel2016\Objective4
Perform operations with formulas 
and functions

Excel_4-1a.xlsx
Excel_4-1b.xlsx
Excel_4-1c.xlsx
Excel_4-2.xlsx
Excel_4-3.xlsx

Excel_4-1a_results.xlsx
Excel_4-1b_results.xlsx
Excel_4-1c_results.xlsx
Excel_4-2_results.xlsx
Excel_4-3_results.xlsx

MOSExcel2016\Objective5
Create charts and objects

Excel_5-1.xlsx
Excel_5-2.xlsx
Excel_5-3a.xlsx
Excel_5-3b.jpg
Excel_5-3c.txt

Excel_5-1_results.xlsx
Excel_5-2_results.xlsx
Excel_5-3_results.xlsx
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Adapt procedure steps
This book contains many images of user interface elements that you’ll work 
with while performing tasks in Excel on a Windows computer. Depending 
on your screen resolution or app window width, the Excel ribbon on your 
screen might look different from that shown in this book. (If you turn on 
Touch mode, the ribbon displays significantly fewer commands than in Mouse 
mode.) As a result, procedural instructions that involve the ribbon might 
require a little adaptation.

Simple procedural instructions use this format:

➜➜ On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, our instructions use this format:

➜➜ On the Home tab, in the Editing group, click the Find arrow and then, 
in the Find list, click Go To.

If differences between your display settings and ours cause a button to 
appear differently on your screen than it does in this book, you can easily 
adapt the steps to locate the command. First click the specified tab, and then 
locate the specified group. If a group has been collapsed into a group list 
or under a group button, click the list or button to display the group’s com-
mands. If you can’t immediately identify the button you want, point to likely 
candidates to display their names in ScreenTips.

The instructions in this book assume that you’re interacting with on-screen 
elements on your computer by clicking (with a mouse, touchpad, or other 
hardware device). If you’re using a different method—for example, if your 
computer has a touchscreen interface and you’re tapping the screen (with 
your finger or a stylus)—substitute the applicable tapping action when you 
interact with a user interface element.

Instructions in this book refer to user interface elements that you click or 
tap on the screen as buttons, and to physical buttons that you press on a 
keyboard as keys, to conform to the standard terminology used in documen-
tation for these products.
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Ebook edition
If you’re reading the ebook edition of this book, you can do the following:

■■ Search the full text

■■ Print

■■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at:

https://aka.ms/MOSExcel2016/detail

Errata, updates, & book support
We’ve made every effort to ensure the accuracy of this book and its companion 
content. If you discover an error, please submit it to us through the link at:

https://aka.ms/MOSExcel2016/errata

If you need to contact the Microsoft Press Book Support team, please send an email 
message to:

mspinput@microsoft.com

For help with Microsoft software and hardware, go to:

https://support.microsoft.com

We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book by completing the survey at: 

https://aka.ms/tellpress

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

https://www.aka.ms/MOSExcel2016/detail
https://www.aka.ms/MOSExcel2016/errata
https://www.support.microsoft.com
https://www.aka.ms/tellpress
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Stay in touch
Let’s keep the conversation going! We’re on Twitter at:

https://twitter.com/MicrosoftPress

https://www.twitter.com/MicrosoftPress
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Taking a Microsoft Office Specialist exam

Desktop computing proficiency is increasingly important in today’s business world. 
When screening, hiring, and training employees, employers can feel reassured by 
relying on the objectivity and consistency of technology certification to ensure the 
competence of their workforce. As an employee or job seeker, you can use technol-
ogy certification to prove that you already have the skills you need to succeed, saving 
current and future employers the time and expense of training you.

Microsoft Office Specialist certification
Microsoft Office Specialist certification is designed to assist students and information 
workers in validating their skills with Office programs. The following certification paths 
are available:

■■ A Microsoft Office Specialist (MOS) is an individual who has demonstrated 
proficiency by passing a certification exam in one or more Office programs, 
including Microsoft Word, Excel, PowerPoint, Outlook, or Access.

■■ A Microsoft Office Specialist Expert (MOS Expert) is an individual who has 
taken his or her knowledge of Office to the next level and has demonstrated by 
passing two certification exams that he or she has mastered the more advanced 
features of Word or Excel.

■■ A Microsoft Office Specialist Master (MOS Master) is an individual who has 
demonstrated a broader knowledge of Office skills by passing the Word and 
Word Expert exams, the Excel and Excel Expert exams, and the PowerPoint, 
Access, or Outlook exam.

Selecting a certification path
When deciding which certifications you would like to pursue, assess the following:

■■ The program and program version(s) with which you are familiar

■■ The length of time you have used the program and how frequently you use it
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■■ Whether you have had formal or informal training in the use of that program

■■ Whether you use most or all of the available program features

■■ Whether you are considered a go-to resource by business associates, friends, 
and family members who have difficulty with the program

Candidates for MOS Expert and MOS Master certification are expected to successfully 
complete a wide range of standard business tasks. Successful candidates generally 
have six or more months of experience with the specific Office program, including 
either formal, instructor-led training or self-study using MOS-approved books, guides, 
or interactive computer-based materials.

Candidates for MOS Expert and MOS Master certification are expected to successfully 
complete more complex tasks that involve using the advanced functionality of the 
program. Successful candidates generally have at least six months, and might have 
several years, of experience with the programs, including formal, instructor-led train-
ing or self-study using MOS-approved materials.

Test-taking tips
Every MOS certification exam is developed from a set of exam skill standards (referred 
to as the objective domain) that are derived from studies of how the Office programs 
are used in the workplace. Because these skill standards dictate the scope of each 
exam, they provide critical information about how to prepare for certification. This 
book follows the structure of the published exam objectives. 

See Also  For more information about the book structure, see “How this book is organized” in 
the Introduction.

The MOS certification exams are performance based and require you to complete 
business-related tasks in the program for which you are seeking certification. For 
example, you might be presented with a document and told to insert and format 
additional document elements. Your score on the exam reflects how many of the 
requested tasks you complete within the allotted time.
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Here is some helpful information about taking the exam:

■■ Keep track of the time. Your exam time does not officially begin until after you 
finish reading the instructions provided at the beginning of the exam. During 
the exam, the amount of time remaining is shown in the exam instruction 
window. You can’t pause the exam after you start it.

■■ Pace yourself. At the beginning of the exam, you will receive information about 
the tasks that are included in the exam. During the exam, the number of com-
pleted and remaining tasks is shown in the exam instruction window.

■■ Read the exam instructions carefully before beginning. Follow all the instructions 
provided completely and accurately.

■■ If you have difficulty performing a task, you can restart it without affecting the 
result of any completed tasks, or you can skip the task and come back to it after 
you finish the other tasks on the exam.

■■ Enter requested information as it appears in the instructions, but without 
duplicating the formatting unless you are specifically instructed to do so. For 
example, the text and values you are asked to enter might appear in the instruc-
tions in bold and underlined text, but you should enter the information without 
applying these formats.

■■ Close all dialog boxes before proceeding to the next exam item unless you are 
specifically instructed not to do so.

■■ Don’t close task panes before proceeding to the next exam item unless you are 
specifically instructed to do so.

■■ If you are asked to print a document, worksheet, chart, report, or slide, perform 
the task, but be aware that nothing will actually be printed.

■■ Don’t worry about extra keystrokes or mouse clicks. Your work is scored based 
on its result, not on the method you use to achieve that result (unless a specific 
method is indicated in the instructions).

■■ If a computer problem occurs during the exam (for example, if the exam does 
not respond or the mouse no longer functions) or if a power outage occurs, 
contact a testing center administrator immediately. The administrator will 
restart the computer and return the exam to the point where the interruption 
occurred, with your score intact.
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Exam Strategy  This book includes special tips for effectively studying for the Microsoft Office 
Specialist exams in Exam Strategy paragraphs such as this one.

Certification benefits
At the conclusion of the exam, you will receive a score report, indicating whether you 
passed the exam. If your score meets or exceeds the passing standard (the minimum 
required score), you will be contacted by email by the Microsoft Certification Program 
team. The email message you receive will include your Microsoft Certification ID 
and links to online resources, including the Microsoft Certified Professional site. On 
this site, you can download or order a printed certificate, create a virtual business 
card, order an ID card, review and share your certification transcript, access the Logo 
Builder, and access other useful and interesting resources, including special offers from 
Microsoft and affiliated companies.

Depending on the level of certification you achieve, you will qualify to display one of 
three logos on your business card and other personal promotional materials. These 
logos attest to the fact that you are proficient in the applications or cross-application 
skills necessary to achieve the certification. Using the Logo Builder, you can create a 
personalized certification logo that includes the MOS logo and the specific programs 
in which you have achieved certification. If you achieve MOS certification in multiple 
programs, you can include multiple certifications in one logo.

For more information
To learn more about the Microsoft Office Specialist exams and related courseware, 
visit:

http://www.certiport.com/mos

http://www.certiport.com/mos
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Microsoft Office Specialist

Exam 77-727

Microsoft  
Excel 2016
This book covers the skills you need to have for certification as a Microsoft 
Office Specialist in Excel 2016. Specifically, you need to be able to complete tasks 
that demonstrate the following skill sets:

1	 Create and manage worksheets and workbooks
2	 Manage data cells and ranges
3	 Create tables
4	 Perform operations with formulas and functions
5	 Create charts and objects

With these skills, you can create and populate Excel workbooks, and format, 
organize, and present the types of data most commonly used in a business 
environment.
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Exam 77-727: Microsoft Excel 2016 

Prerequisites
We assume that you have been working with Excel 2016 for at least six months and that 
you know how to carry out fundamental tasks that are not specifically mentioned in the 
objectives for this Microsoft Office Specialist exam. Before you begin studying for this 
exam, you might want to make sure you are familiar with the information in this section.

Select content
To select all the content in a worksheet

➜➜ At the junction of the row and column headings (above row 1 and to the left of 
column A), click the Select All button.

To select an individual worksheet column or row

➜➜ Click the column heading (labeled with the column letter) or the row heading 
(labeled with the row number).

To select data in a table, table column, or table row

➜➜ Point to the upper-left corner of the table. When the pointer changes to a diagonal 
arrow, click once to select only the data, or twice to select the data and headers.

Tip  This method works only with tables, not with data ranges.

➜➜ Point to the top edge of the table column. When the pointer changes to a 
downward-pointing arrow, click once to select only the data, or twice to select 
the data and header.

Tip  You must point to the edge of the table, not to the column heading or row heading.

➜➜ Point to the left edge of the table row. When the pointer changes to a 
right-pointing arrow, click once to select the data.

Manage data entry
You enter text or a number in a cell simply by clicking the cell and entering the con-
tent. When entering content, a Cancel button (an X) and an Enter button (a check 
mark) are located between the formula bar and Name box, and the indicator at the 
left end of the status bar changes from Ready to Enter.
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Excel allows a long text entry to overflow into an adjacent empty cell and truncates 
the entry only if the adjacent cell also contains an entry. However, unless you tell it 
otherwise, Excel displays long numbers in their simplest form, as follows:

■■ If you enter a number with fewer than 12 digits in a standard-width cell (which 
holds 8.43 characters), Excel adjusts the width of the column to accommodate 
the entry.

■■ If you enter a number with 12 or more digits, Excel displays it in scientific nota-
tion. For example, if you enter 12345678912345 in a standard-width cell, Excel 
displays 1.23457E+13 (1.23457 times 10 to the thirteenth power).

■■ If you enter a value with many decimal places, Excel might round it. For exam-
ple, if you enter 123456.789 in a standard-width cell, Excel displays 123456.8.

■■ If you manually set the width of a column and then enter a numeric value that is 
too large to be displayed in its entirety, Excel displays pound signs (#) instead of 
the value.

To complete data entry

➜➜ Click the Enter button (the check mark) on the formula bar to complete the 
entry and stay in the same cell.

➜➜ Press Enter or the Down Arrow key to complete the entry and move down to 
the next cell in the same column.

➜➜ Press the Tab key or the Right Arrow key to complete the entry and move (to 
the right) to the next cell in the same row, or to the next cell in the table (which 
might be the first cell of the next row).

➜➜ Press Shift+Enter or the Up Arrow key to complete the entry and move up to 
the previous cell in the same column.

➜➜ Press Shift+Tab or the Left Arrow key to complete the entry and move (to the 
left) to the previous cell in the same row.

Manage worksheets
To delete a worksheet

➜➜ Right-click the worksheet tab, and then click Delete.

➜➜ With the worksheet active, on the Home tab, in the Cells group, click the Delete 
arrow, and then click Delete Sheet.
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Reuse content
Excel offers several methods of cutting and copying content. After selecting the 
content, you can click buttons on the ribbon, use a keyboard shortcut, or right-click 
the selection and click commands on the shortcut menu. Cutting or copying content 
places it on the Microsoft Office Clipboard, which is shared by Excel and other Office 
programs such as Word and PowerPoint. You can paste content that is stored on the 
Clipboard into a workbook (or any Office file) by using commands from the ribbon, 
shortcut menu, or keyboard, or directly from the Clipboard. 

Experienced users might find it fastest to use a keyboard shortcut. The main keyboard 
shortcuts for editing tasks are shown in the following table.

Task Keyboard shortcut

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Undo Ctrl+Z

Repeat/Redo Ctrl+Y

Exam Strategy  When you paste content onto an Excel worksheet, the Paste Options menu 
presents options for formatting the pasted content. Exam 77-727 requires that you demon-
strate the ability to use common paste options, including pasting values, pasting without 
formatting, and transposing data.

Excel shares the Office Clipboard with Word and other programs in the Microsoft 
Office suite of products. You can easily reuse content from one Office file in another.

To paste cells from the Clipboard to a data range

1.	 Select the upper-left cell of the area into which you want to insert the cut or 
copied cells.

2.	 On the Home tab, in the Cells group, click the Insert arrow, and then click Insert 
Cut Cells or Insert Copied Cells.

3.	 In the Insert Paste dialog box, click Shift cells right or Shift cells down to move 
the existing data. Then click OK.
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To paste cells from the Clipboard over existing data

1.	 Select the upper-left cell of the area into which you want to insert the cut or 
copied cells.

2.	 Do either of the following:

●● On the Home tab, in the Clipboard group, click Paste.

●● Press Ctrl+V.

Access program commands and options
Commands for working with Excel workbooks (rather than worksheet content) are 
available from the Backstage view. You display the Backstage view by clicking the File 
tab on the ribbon.

The Backstage view displays information about the current workbook
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The links in the left pane of the Backstage view provide access to 11 pages that contain 
information about the current workbook, commands for working with the workbook 
or active worksheet, or commands for working with Excel. To display the Info, New, 
Open, Save As, History, Print, Share, Export, Account, Options, or Feedback page, click 
the page name in the left pane.

You manage many aspects of Excel functionality from the Excel Options dialog box, 
which you open by clicking Options in the left pane of the Backstage view.

The Excel Options dialog box

The Excel Options dialog box has 10 separate pages of commands, organized by 
function. To display the General, Formulas, Proofing, Save, Language, Advanced, 
Customize Ribbon, Customize Quick Access Toolbar, Add-ins, or Trust Center page of 
the Excel Options dialog box, click the page name in the left pane.
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Objective group 5

Create charts and 
objects
The skills tested in this section of the Microsoft Office Specialist exam for 
Microsoft Excel 2016 relate to creating charts and objects. Specifically, the 
following objectives are associated with this set of skills:

5.1	  Create charts
5.2	  Format charts
5.3	  Insert and format objects

You can store a large amount of data in an Excel workbook. When you want to 
present that data to other people, you might choose to include additional infor-
mation to help viewers interpret the information, or to present the data in the 
form of a chart. Using Excel 2016, you can create many types of charts from data 
stored on one or more worksheets. To simplify the process of choosing a chart 
type, the Quick Analysis tool recommends charts that are most appropriate for 
the data you’re working with. To aid viewers in interpreting the chart data, you 
can configure a chart to include identifying elements such as a title, legend, and 
data markers.

You can enhance the information you present in a workbook by including 
images such as company logos directly on worksheets, displaying text and 
graphics in SmartArt business diagrams, and displaying text independent of 
the worksheet or chart sheet structure within text boxes.

This chapter guides you in studying ways of presenting data in charts and 
enhancing worksheets by including images, business diagrams, and text boxes.

To complete the practice tasks in this chapter, you need the practice files  
contained in the MOSExcel2016\Objective5 practice file folder. For more  
information, see “Download the practice files” in this book’s introduction.



144

Objective group 5  Create charts and objects

Objective 5.1: Create charts
Charts (also referred to as graphs) are created by plotting data points onto a two- 
dimensional or three-dimensional axis to assist in data analysis and are therefore a 
common component of certain types of workbooks. Presenting data in the form of a 
chart can make it easy to identify trends and relationships that might not be obvious 
from the data itself.

Different types of charts are best suited for different types of data. The following table 
shows the available chart types and the data they are particularly useful for plotting.

Chart type Typically used to show Variations

Area Multiple data series as cumulative 
layers showing change over time

Two-dimensional or 
three-dimensional
Independent or stacked data 
series

Bar Variations in value over time or 
the comparative values of several 
items at a single point in time

Two-dimensional or 
three-dimensional
Stacked or clustered bars
Absolute or proportional values

Box & Whisker Distribution of data within a range, 
including mean values, quartiles, 
and outliers

Column Variations in value over time or 
comparisons

Two-dimensional or 
three-dimensional
Stacked or clustered columns
Absolute or proportional values

Funnel Categorized numeric data such as 
sales or expenses

Histogram Frequency of occurrence of values 
within a data set

Optional Pareto chart includes 
additive contributions 
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Chart type Typically used to show Variations

Line Multiple data trends over evenly 
spaced intervals

Two-dimensional or 
three-dimensional
Independent or stacked lines
Absolute or proportional values
Can include markers

Pie Percentages assigned to different 
components of a single item 
(nonnegative, nonzero, no more 
than seven values)

Two-dimensional or 
three-dimensional
Pie or doughnut shape
Secondary pie or bar subset

Radar Percentages assigned to different 
components of an item, radiating 
from a center point

Can include markers and fills

Stock High, low, and closing prices of 
stock market activity

Can include opening price and 
volume traded

Sunburst Comparisons of multilevel 
hierarchical data

Surface Trends in values across two 
different dimensions in a 
continuous curve, such as a 
topographic map

Two-dimensional or 
three-dimensional
Contour or surface area

Treemap Comparisons of multilevel 
hierarchical data

X Y (Scatter) Relationships between sets of 
values

Data points as markers or bubbles
Optional trendlines

Waterfall The effect of positive and negative 
contributions on financial data

Optional connector lines

You can also create combination charts that overlay different data charts in one space.
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To plot data as a chart, all you have to do is select the data and specify the chart type. 
You can select any type of chart from the Charts group on the Insert tab. You can also 
find recommendations based on the selected content either on the Charts tab of the 
Quick Analysis tool or on the Recommended Charts tab of the Insert Chart dialog box.

Excel displays the active data in each of the recommended chart thumbnails

Tip  The Quick Analysis tool provides access to formatting options that pertain to the currently 
selected data. From the tabs of the Quick Analysis tool, you can apply conditional formatting, 
perform mathematical operations, create tables and PivotTables, and insert sparklines. Like the 
Mini Toolbar, the Paste Options menu, and other context-specific tools, the Quick Analysis tool 
makes existing functionality available in a central location. The reason this is a tool rather than 
simply a toolbar or menu is that the options shown in the tool—for example, the charts shown 
on the Charts tab—are selected as appropriate for the current data.

Before you select the data that you want to present as a chart, ensure that the data is 
correctly set up for the type of chart you want to create (for example, you must set up 
hierarchical categories differently for a box & whisker, sunburst, or treemap chart than 
for a bar or column chart). Select only the data you want to appear in the chart. If the 
data is not in a contiguous range of rows or columns, either rearrange the data or hold 
down the Ctrl key while you select noncontiguous ranges.
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A chart is linked to its worksheet data, so any changes you make to the plotted data 
are immediately reflected in the chart. If you want to add or delete values in a data 
series or add or remove an entire series, you need to increase or decrease the range of 
the plotted data in the worksheet.

Change a chart by including more or less data

Sometimes a chart does not produce the results you expect because the data series 
are plotted against the wrong axes; that is, Excel is plotting the data by row when 
it should be plotting by column, or vice versa. You can quickly switch the rows and 
columns to see whether that produces the desired effect. You can preview the effect of 
switching axes in the Change Chart Type dialog box.

You can present a different view of the data in a chart by switching the data series and 
categories across the axis.

Change a chart by switching the data series and categories
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You can swap data across the axis from the Change Chart Type dialog box or you can 
more precisely control the chart content from the Select Data Source dialog box.

Choosing the data to include in a chart

Exam Strategy  Practice plotting the same data in different ways. In particular, understand the 
effects of plotting data by column or by row.

To plot data as a chart on the worksheet

1.	 On the worksheet, select the data that you want to plot in the chart.

2.	 Do any of the following:

●● On the Insert tab, in the Charts group, click the general chart type you want, 
and then on the menu, click the specific chart you want to create.

Tip  Pointing to a chart type on the menu displays a live preview of the selected 
data plotted as that chart type.

●● On the Insert tab, in the Charts group, click Recommended Charts. Preview 
the recommended charts by clicking the thumbnails in the left pane. Then 
click the chart type you want, and click OK.

●● Click the Quick Analysis button that appears in the lower-right corner of the 
selection, click Charts, and then click the chart type you want to create.
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The Quick Analysis menu provides quick access to data transformation options

To modify the data points in a chart

➜➜ In the linked Excel worksheet, change the values within the chart data.

To select the chart data on the linked worksheet

➜➜ Click the chart area or plot area.

Selecting data on the chart selects the corresponding data on the worksheet

To change the range of plotted data in a selected chart

➜➜ In the linked Excel worksheet, drag the corner handles of the series selectors 
until they enclose the series you want to plot.

Or



150

Objective group 5  Create charts and objects

1.	 Do either of the following:

●● On the Design tool tab, in the Data group, click Select Data.

●● Right-click the chart area or plot area, and then click Select Data.

2.	 In the Select Data Source dialog box, do any of the following, and then click OK:

●● Click the worksheet icon at the right end of the Chart data range box, and 
then drag to select the full range of data you want to have available.

●● In the Legend Entries (Series) list and Horizontal (Category) Axis Labels boxes, 
select the check boxes of the rows and columns of data you want to plot.

To plot additional data series in a selected chart

1.	 Do either of the following:

●● On the Design tool tab, in the Data group, click Select Data.

●● Right-click the chart area or plot area, and then click Select Data.

2.	 In the Select Data Source dialog box, at the top of the Legend Entries (Series) 
list, click Add.

3.	 In the Edit Series dialog box, do either of the following:

●● Enter the additional series in the Series name box.

●● Click in the Series name box and then drag in the worksheet to select the 
additional series. 

4.	 If necessary, enter or select the series values. Then click OK.

5.	 In the Select Data Source dialog box, click OK.

To switch the display of a data series in a selected chart between the series axis and 
the category axis

➜➜ On the Design tool tab, in the Data group, click the Switch Row/Column 
button.

Or

1.	 Do either of the following:

●● On the Design tool tab, in the Data group, click Select Data.

●● Right-click the chart area or plot area, and then click Select Data.

2.	 In the Select Data Source dialog box, click Switch Row/Column, and then click OK.
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Objective 5.1 practice tasks
The practice file for these tasks is located in the MOSExcel2016\Objective5 
practice file folder. The folder also contains a result file that you can use to 
check your work.

➤➤ Open the Excel_5-1 workbook and do the following:

❑❑ Plot the data on the Seattle worksheet as a 2-D Pie chart on that 
worksheet.

❑❑ Plot the data on the Sales worksheet as a simple two-dimensional 
column chart.

➤➤ On the Fall Sales worksheet, do the following:

❑❑ Switch the rows and columns of the chart.

❑❑ Change the October sales amount for the Flowers category to 
888.25 and ensure that the chart reflects the change.

❑❑ Expand the data range plotted by the chart to include November,  
so that you can compare sales for the two months.

➤➤ Save the Excel_5-1 workbook.

➤➤ Open the Excel_5-1_results workbook. Compare the two workbooks to 
check your work.

➤➤ Close the open workbooks.
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Objective 5.2: Format charts
A chart includes many elements, some required and some optional. The chart con-
tent can be identified by a chart title. Each data series is represented in the chart by 
a unique color. A legend that defines the colors is created by default but is optional. 
Each data point is represented in the chart by a data marker, and can also be repre-
sented by a data label that specifies the data point value. The data is plotted against 
an x-axis (or category axis) and a y-axis (or value axis). Three-dimensional charts also 
have a z-axis (or series axis). The axes can have titles, and gridlines can more precisely 
indicate the axis measurements.

To augment the usefulness or the attractiveness of a chart, you can add elements. You 
can adjust each element in appropriate ways, in addition to adjusting the plot area 
(the area defined by the axes) and the chart area (the entire chart object). You can 
move and format most chart elements, and easily add or remove them from the chart.

Chart elements can eliminate the need for other explanatory text

Tip  Data labels can clutter up all but the simplest charts. If you need to show the data for a 
chart on a separate chart sheet, consider using a data table instead.
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You can add and remove chart elements from the Chart Elements pane or from the 
Design tool tab.

The options in the Chart Elements pane vary based on the chart type

Exam Strategy  You can tailor the elements of charts in too many ways for us to cover them in 
detail here. In addition to choosing options from galleries, you can open a Format dialog box 
for each type of element. Make sure you are familiar with the chart elements and how to use 
them to enhance a chart.

By default, Excel creates charts on the same worksheet as the source data. You can 
move or size a chart on the worksheet by dragging the chart or its handles, or by 
specifying a precise position or dimensions. If you prefer to display a chart on its own 
sheet, you can move it to another worksheet in the workbook, or to a dedicated chart 
sheet.

Move a chart to its own sheet to remove the distraction of the background data
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You can apply predefined combinations of layouts and styles to quickly format a chart. 
You can also apply a shape style to the chart area to set it off from the rest of the sheet.

Preset formatting options make it easy to achieve the look you want

If the chart you initially create doesn’t depict your data the way you want, you can 
change the chart type or select a different variation of the chart. Many chart types 
have two-dimensional and three-dimensional variations or optional elements.
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Preview chart data in other types of charts

To display and hide chart elements

➜➜ Click the chart, and then click the Chart Elements button (labeled with a plus 
sign) that appears in the upper-right corner of the chart. In the Chart Elements 
pane, select the check boxes of the elements you want to display, and clear the 
check boxes of the elements you want to hide.

➜➜ On the Design tool tab, in the Chart Layouts group, click Add Chart Element, 
click the element type, and then click the specific element you want to display 
or hide.

➜➜ On the Design tool tab, in the Chart Layouts group, click Quick Layout, and 
then click the combination of elements you want to display.
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To resize a chart

➜➜ Select the chart, and then drag the sizing handles.

➜➜ On the Format tool tab, in the Size group, enter the Height and Width dimensions.

➜➜ On the Format tool tab, click the Size dialog box launcher, and enter the Height 
and Width dimensions or Scale Height and Scale Width percentages on the 
Size & Properties page of the Format Chart Area pane.

To move a selected chart

➜➜ Drag the chart to another location on the worksheet.
Or

1.	 On the Design tool tab, in the Location group, click Move Chart.

2.	 In the Move Chart dialog box, select a location and click OK.

To change the type of a selected chart

1.	 On the Design tool tab, in the Type group, click Change Chart Type.

2.	 In the Change Chart Type dialog box, click a new type and sub-type, and then 
click OK.

To apply a style to a selected chart

➜➜ On the Design tool tab, in the Chart Styles gallery, click the style you want.

➜➜ Click the Chart Styles button (labeled with a paintbrush) that appears in the 
upper-right corner of the chart. On the Style page of the Chart Styles pane, click 
the style you want.

To apply a shape style to a selected chart

➜➜ On the Format tool tab, in the Shape Styles gallery, click the style you want.

To change the color scheme of a selected chart

➜➜ On the Design tool tab, in the Chart Styles group, click Change Colors, and 
then click the color scheme you want.

➜➜ Click the Chart Styles button that appears in the upper-right corner of the chart. 
On the Color page of the Chart Styles pane, click the color scheme you want.

➜➜ Apply a different theme to the workbook.

See Also  For information about applying themes, see “Objective 1.3: Format work-
sheets and workbooks.”



Objective 5.2: Format charts

157

Objective 5.2 practice tasks
The practice files for these tasks are located in the MOSExcel2016\
Objective5 practice file folder. The folder also contains a result file that you 
can use to check your work.

➤➤ Open the Excel_5-2 workbook, display the Sales worksheet, and do the 
following:

❑❑ Change the pie chart to a 3-D Clustered Column chart.

❑❑ Apply Layout 1, Style 7 to the chart.

❑❑ Apply the Subtle Effect – Olive Green, Accent 3 shape style.

❑❑ Increase the size of the chart until it occupies cells A1:L23.

❑❑ Move the chart to a new chart sheet named Sales Chart.

➤➤ On the Seattle worksheet, do the following:

❑❑ Add the title Air Quality Index Report to the chart.

❑❑ Add data labels that show the percentage of the whole that is 
represented by each data marker.

➤➤ Save the Excel_5-2 workbook.

➤➤ Open the Excel_5-2_results workbook. Compare the two workbooks to 
check your work.

➤➤ Close the open workbooks.
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Objective 5.3: Insert and format objects
Although graphics are not frequently associated with the storage of data within 
Excel workbooks, it is worthwhile to note that when preparing to present data, you 
can incorporate almost all of the graphic elements available in Microsoft Word and 
PowerPoint into an Excel workbook. This can be particularly useful when creating 
summary pages or when a workbook must provide a standalone information source 
for text content in addition to data.

Tip  You use the same methods to insert and format graphic objects in Excel as you do in other 
Microsoft Office programs. As an experienced Excel user, you are likely familiar with the meth-
ods for inserting, creating, and configuring graphic objects in other programs.

Insert text boxes and shapes
To convey information more succinctly, you can add text. When you add text directly 
to a worksheet, you are restricted by the width and height of the worksheet cells in 
which you must insert the text. To bypass that restriction or to distinctly separate the 
text from the worksheet data, you can insert the text in a text box or shape that you 
can position independently on the worksheet. You can also use shapes as simple navi-
gational aids that use hyperlinks to move to a specific location.
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Text within a text box or shape is independent of the worksheet content

Shapes can be simple, such as lines, circles, or squares; or more complex, such as stars, 
hearts, and arrows. You can enter text inside a shape, and apply formatting effects to 
both the shape and the text. You format both text boxes and shapes by using com-
mands on the Format tool tab for Drawing Tools.

Easily apply formatting that matches the color scheme of other workbook elements
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To insert a text box on a worksheet

1.	 On the Insert tab, in the Text group, click Text Box.

2.	 In the worksheet, click to insert a small (one character) text box that expands 
when you enter text, or drag to draw the text box the size that you want.

3.	 Enter or paste the text you want to display in the text box.

To draw a shape

1.	 On the Insert tab, in the Illustrations group, click the Shapes button.

More than 150 shapes are available as starting points for a custom shape

2.	 In the Shapes gallery, click the shape you want, and then do one of the 
following:

●● Click anywhere on the page to insert a standard-size shape.

●● Drag anywhere on the page to draw a shape of the size and aspect ratio that 
you want.

Tip  To draw a shape with a 1:1 aspect ratio (equal height and width), hold down the 
Shift key while dragging.
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To add text to a shape

➜➜ Click the shape to select it, and then enter the text.

➜➜ Right-click the shape, click Add Text or Edit Text, and then enter the text.

To format a selected text box or shape

➜➜ To change the shape, on the Format tool tab, in the Insert Shapes group, click 
Edit Shape, click Change Shape, and then click the shape you want.

➜➜ To change the shape fill, outline, or effects, on the Format tool tab, use the for-
matting options in the Shape Styles group.

➜➜ To rotate the shape, on the Format tool tab, in the Arrange group, click Rotate 
Objects, and then click the rotation option you want.

To resize a text box or shape

➜➜ Click the text box or shape to select it, and then do any of the following:

●● Drag the top or bottom sizing handle to change the height.

●● Drag the left or right sizing handle to change the width.

●● Drag a corner sizing handle to change the width and height and maintain 
the aspect ratio.

●● On the Format tool tab, in the Size group, enter or select the Height and 
Width dimensions.

●● On the Format tool tab, in the Size group, click the dialog box launcher. In 
the Format Object dialog box that opens, select the Lock aspect ratio check 
box if you want to maintain the aspect ratio, and then enter or select the 
height or width.

To format text in a text box or shape

➜➜ Select the text box or shape. On the Format tool tab, use the formatting options 
in the WordArt Styles group.

➜➜ Select the text, and then use the formatting options on the Mini Toolbar or in 
the Font group on the Home tab.
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Insert images
You can enhance workbook content by adding an image, perhaps a company logo, 
a product image, or an image that represents the concept you want to convey to the 
workbook viewer.

Add a product image to a worksheet that you will use as a catalog page

After you insert an image in a document, you can modify it in many ways. For exam-
ple, you can crop or resize a picture, change the picture’s brightness and contrast, 
recolor it, apply artistic effects to it, and compress it to reduce the size of the docu-
ment containing it. You can apply a wide range of preformatted styles to a picture to 
change its shape and orientation, in addition to adding borders and picture effects.

You format images by using commands on the Format tool tab for Pictures.

You can format an image in Excel in the same ways that you do in PowerPoint or Word
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To insert a picture on a worksheet

1.	 On the Insert tab, in the Illustrations group, click the Pictures button.

2.	 In the Insert Picture dialog box, browse to and click the file you want. Then do 
one of the following:

●● Click Insert to insert the picture into the worksheet.

●● In the Insert list, click Link to File to insert a picture that will update auto-
matically if the picture file changes.

●● In the Insert list, click Insert and Link to insert a picture that you can manu-
ally update if the picture file changes.

To apply artistic effects to a selected picture on a worksheet

➜➜ On the Format tool tab, in the Adjust group, click Artistic Effects, and then in 
the gallery, click the effect you want to apply.

To apply a style to a selected picture on a worksheet

➜➜ On the Format tool tab, in the Picture Styles group, expand the Quick Styles 
gallery, and then click the style you want to apply.

Or

1.	 On the Format tool tab, click the Picture Styles dialog box launcher.

2.	 In the Format Picture pane, on the Fill & Line and Effects pages, choose the 
options that you want to apply.

To change the size and/or shape of a selected picture on a worksheet

➜➜ Drag its sizing handles.

➜➜ On the Format tool tab, in the Size group, change the Height and Width 
settings.

➜➜ On the Format tool tab, click the Size dialog box launcher. Then on the Size & 
Properties page of the Format Picture pane, change the Height, Width, and 
Scale settings.

To move a picture on a worksheet

➜➜ Drag the picture to a new location.
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To copy a picture to a new location on a worksheet

➜➜ Hold down the Ctrl key and drag the picture to the second location.

To format a selected picture

➜➜ Use the commands in the Adjust group on the Format tool tab to remove the 
picture background; adjust the sharpness, brightness, and contrast; apply artis-
tic effects; and compress the picture to minimize the file size.

➜➜ Use the commands in the Picture Styles group on the Format tool tab to apply 
preconfigured combinations of effects or to apply a border, shadow, reflection, 
glow, soft edge, beveled edge, or three-dimensional effect.

➜➜ Use the commands in the Arrange group on the Format tool tab to control the 
relationship of the picture to the sheet and to other pictures on the sheet, and 
to rotate or flip the picture.

➜➜ Use the commands in the Size group on the Format tool tab to change the 
picture height and width and to crop the picture manually, to a specific aspect 
ratio, to a shape, or to fill or fit a specific space.

Provide alternative text for accessibility
Alternative text (also referred to as alt text) is descriptive text assigned to an Excel 
table, chart, image, or other object that either might not show up correctly on the 
page or might not be available to screen reading software. The alternative text pro-
vides readers with information about the object content or purpose. In a PDF file, for 
example, if your content includes alternative text, a reader can point to an image on 
the screen to display a description of the image. 

You assign alternative text to an object as an object property. You can assign both a 
title and a description to an image.

To add alternative text to an object

1.	 Do one of the following:

●● Right-click the chart area of a chart, and then click Format Chart Area.

●● Right-click a text box or shape, and then click Format Shape.

●● Right-click an image, and then click Format Picture.
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2.	 In the Format Object pane, click the Size & Properties button, and then click 
the Alt Text heading to display the input boxes, if they aren’t already visible.

3.	 In the Title box, enter a short title for the object. People who use screen read-
ing software will hear the title first and can then choose whether to have the 
description read.

4.	 In the Description box, enter a description that provides the information you 
intend for a reader to get from looking at the object.

Alt text provides a text description of a visual object

Excel saves your changes in the object properties.
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Objective 5.3 practice tasks
The practice file for these tasks is located in the MOSExcel2016\Objective5 
practice file folder. The folder also contains a result file that you can use to 
check your work.

➤➤ Open the Excel_5-3a workbook, display the Summary sheet, and do 
the following:

❑❑ Insert the Excel_5-3b logo in the upper-left corner of the sheet.

❑❑ Insert a text box on the sheet. Configure the text box to be three 
inches wide and three inches high, and align it below the heading 
“Our Prediction.” 

❑❑ Insert the content of the Excel_5-3c text file into the text box. 
Format the text in 20-point orange Candara font, and center it in 
the text box.

❑❑ Add alternative text to the logo, using the title Company logo and 
the description Cartoon image of a person wearing an airplane 
costume.

➤➤ Save the Excel_5-3a workbook.

➤➤ Open the Excel_5-3_results workbook. Compare the two workbooks to 
check your work.

➤➤ Close the open workbooks.
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A
absolute references  120

See also formulas
accessibility

adding alternative text to objects  164–165
checking workbooks for  60–62

Accessibility Checker  58–59
activating page footer/header areas  33
adapting procedure steps  x
addition and subtraction in calculations  124
Adobe Acrobat, additional commands  51
alignment in cells  80–81
alternative text

adding to objects  164–165
displaying for hyperlinks  23

area charts  144
arguments (variables)  125–126
Auto Fill  67
AVERAGE() function  125, 128
AVERAGEIF()/AVERAGEIFS() functions  132–133

B
Backstage view  5
backward compatibility, maintaining  62
bar charts  144
basic document properties, changing  46
blank workbooks, creating  9
book organization  viii
box & whisker charts  144
building custom headers  32
built-in styles  See styles

C
calculation rows, adding  110
calculations

See also formulas; functions
order of precedence  124
by using functions  125–126

category axis  150, 152
cell fill, conditional formatting rules  92

cell formatting
See also conditional formatting
applying  83
based on content  90
pasting without content  74

cell ranges
converting from tables  106
creating tables from  100–101
filling  70–71
referencing in formulas  120–121

cell styles, applying  83
cell values, pasting  74
cells

aligning entries in  81
alignment  80
applying number formats  84
applying styles  83
changing orientation of text in  82–83
copying formatting  88
copying numeric data to  70
copying text to adjacent cells  70
creating series based on selection of  67
deleting conditional formatting  93
displaying percentages  85
entering content in  2
fill formatting to adjacent cells  88
filling using Flash Fill  76–77
font attributes  83
indentation  80
indenting contents of  82
linking to in workbooks  22
merging  79
moving to named  17
orientation of entries  80
overflow in  2
referencing in formulas  120–121
selecting hyperlinks within  18
text wrapping  80
transposing content  73
wrapping long entries in  81
zooming in on selected  43

Index
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charts

charts
applying styles to  156
axes  152
changing color scheme  156
changing display of data series in  150
changing plotted data ranges  149–150
changing shape style  156
changing type of  156
changing view of data  147
chart title  152
combining layouts/styles  154
creating  144–147
data labels/markers/points  152
default location of  153
displaying/hiding elements  155
elements of  152–154
legends  152
modifying data points in  149
moving  156
plotting additional data series in  150
plotting data on worksheets as  148
resizing  156
switching between axes  150
titles  152
troubleshooting results  147
types  144–145

color scales formatting rule  90
color schemes, changing for charts  156
column charts  144
column titles, displaying repeating  56
columns

See also table columns
changing width of  28–29
deleting  27
finding hidden  37
freezing/unfreezing  44
hiding/unhiding  36–37
horizontal/vertical alignment  80
inserting  27
managing, overview  26
outlining data by  96
selecting  2
selecting data in  2
sizing to fit content  28
text wrapping in  80
transposing  75

commands
in Backstage View  5–6
image formatting  162
Quick Access Toolbar  40

comma-separated (.csv), importing data 
from  13

comparison in calculations  124
compatibility, checking workbooks for  60–62
Compatibility Checker  60–63
CONCAT() function  71, 137–138, 141
CONCATENATE() function  137
concatenation in calculations  124
conditional formatting  90

See also formatting
applying default value of rule  91
based on relationship of values in data 

range  92‑
cell fill  92
deleting from cells  93
font color  92
formatting rules  90

conditional operations using functions  132–135
conditional tests, returning values based on  134
copying

excluding formatting when  71
text, currency, or numeric data to cells  70
worksheets  11–12

COUNT() function  125, 127
COUNTA() function  125, 128
COUNTBLANK() function  125
COUNTIF()/COUNTIFS() functions  132–133
currency

copying amounts to adjacent cells  70
displaying numbers as  86

custom fill series  69–70
custom headers, building  32
custom paper size, setting  31

D
data

completing entries  3
entering  2
filling cells using Flash Fill  75–76
finding within workbooks/worksheets  15
importing .csv/.txt files  13
inserting into data ranges  74
outlining  95–97
overflow in cells  2
pasting  71–72
replacing  76–77
reusing  71–75
selecting  2
subtotals  95–97
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formulas

fill formatting  88
fill handles, using  69
filling

date, day, or numeric series  67–70
excluding formatting when  71

filter buttons  110
filtering tables  110, 115–116
filters  116
finding  See searching
first column/row, freezing  44
first column/row, unhiding  37
Flash Fill  75–76
folders, linking to existing  19
font color, conditional formatting  92
footers  32, 34
formatting

See also conditional formatting
cell alignment  80
clearing from tables  109
copying between cells  88
excluding when copying or filling data  71
fill formatting to adjacent cells  88
horizontal/vertical alignment  80
images  162
indenting cells  80
pictures  164
rule types  90
searching for  16
shapes  161
table elements  110–111
tables  100–101
text, by using functions  137–140
text boxes  161
text in shapes/text boxes  161
text wrapping  80

Formula AutoComplete  125
formulas

See also absolute references; calculations; 
functions

absolute references  120, 122
addition and subtraction in  124
averaging values in data ranges  128, 135
capitalizing each word in text strings  141
comparison in calculations  124
concatenation in calculations  124
converting text strings to uppercase  140
counting cells containing numeric values  127
counting cells in data ranges based on 

conditions  135

summarizing cell subsets  96
transposing  75

data bars formatting rule  90
data labels  152
data markers  152
data points  149, 152
data ranges

averaging values in  128
changing in charts  149–150
conditional formatting  92
converting to tables  102–103
creating subtotals  97–98
inserting data into  74

data series
applying custom  70
creating  66–67
creating custom  69
filling numeric, day, or date  68–69
plotting in charts  150
setting advanced options for  69
switching display between axes  150

date series  68–69
day series  68–69
decimal places, displaying more/fewer  87
delimited text files  12, 51
document properties  45–46

E
ebook edition of book  xi
email messages, creating through hyperlinks  23
errata, submitting  xi
exam  See Microsoft Office Specialist exam
Excel 97-2003 format  50
Excel Macro-Enabled Workbook format  50
Excel Options dialog box  6
Excel Template format  51
exponentiation in calculations  124
external files/locations, linking to  18

F
feedback, submitting  xi
files

linking to existing  19
saving in alternative formats with default 

settings  52
saving in PDF or XPS format  53
saving workbooks in alternative 

formats  50–51
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freezing columns/rows

formulas (continued)
counting empty/non-empty cells  128
defining order of operations  124
defining precedence  124
displaying in worksheets  43
entering arguments in  126
exponentiation in calculations  124
inserting cell references  122
joining multiple text strings into one cell  141
mixed references  120–121
multiplication and division in 

calculations  124
negation in calculations  124
percentages in calculations  124
reference operators in  124
referencing cells  120–121, 123
relative references  120–122
returning characters from text 

strings  139–140
returning characters from within text 

strings  139
returning values based on conditional 

tests  134
summing values  127, 134

freezing columns/rows  44
functions

See also calculations; formulas
arguments (variables)  125–126
AVERAGE()  125, 128
AVERAGEIF()/AVERAGEIFS()  132–133
CONCAT()  137–138, 141
CONCATENATE()  71, 137
conditional operations  132–135
COUNT()  125, 127
COUNTA()  125, 128
COUNTBLANK()  125
COUNTIF()/COUNTIFS()  132–133
displaying on status bar  126
formatting text by using  137–140
IF()  132
indicating  125
LEFT()  137, 139
LOWER()  137–138, 140
MAX()  125, 129
MID()  137–139
MIN()  125, 129
modifying text by using  137–140
performing calculations by using  125–126
PROPER()  137–138, 141
RIGHT()  137, 140

SUM()  125
SUMIF()/SUMIFS()  132
UPPER()  137–138, 140

funnel charts  144

G
Go To Special dialog box, opening  17
graphic elements  See images; shapes; SmartArt 

graphics
graphs  See charts
growth series  67

H
header rows  109–110
headers  32, 34
height of rows, changing  27
hidden columns/rows, finding/unhiding  37
hidden worksheets, displaying  37
hiding columns/rows  36
hiding worksheets  37
highlight cells formatting rule  90
histogram charts  144
hyperlinks

See also linking
for creating email messages  23
displaying alternative text for  23
editing  23
removing  23
to webpages, creating  19
within cells, selecting  18

I
icon sets formatting rule  90
IF() function  132
ignoring print area  49
images

adding artistic effects to  163
applying styles to  163
changing shape/size of  163
copying to new location  164
formatting  164
formatting commands  162
inserting  162–163
moving  163

indenting content in cells  80–81
Insert Hyperlink dialog box, opening  18
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paste options

inserting
columns/rows  27
footers/headers  32
worksheets  10

inspecting workbooks for issues  58–60
inspecting workbooks for properties and 

personal information  56

K
keyboard shortcuts  4

L
LEFT() function  137, 139
legend  152
line charts  145
linear series  67
linking

See also hyperlinks
to files/folders  19, 21
to worksheet elements  22

local templates, creating workbooks from  10
LOWER() function  137–138, 140

M
magnifying worksheets  42
maintaining backward compatibility  62
margins  See page margins, changing
MAX() function  125, 129
merging cells  79
messages, creating through hyperlinks  23
Microsoft Office Specialist

certification  xiii–xvi
exam  xiv–xv
objective domains  xiv
prerequisites  2

Microsoft Word documents  See documents
MID() function  137–139
MIN() function  125, 129
mixed references  120–121
Move Or Copy dialog box, opening  11
moving

charts  156
to locations with specific properties  17
to named cells  17
to ranges  17

to workbook elements  17
worksheets  11

multiple columns/rows, freezing  44
multiplication and division in calculations  124

N
named cells, finding/moving to  17
named objects, linking to  22
naming tables  100–101, 103–104
negation in calculations  124
Normal view  41
number formats

applying  87
applying to cells  84
default  2

numbers  85–87, 116
num_chars argument in functions  137–138
numeric data, copying to adjacent cells  70
numeric series  68–69

O
objects

adding alternative text to  164–165
adding text to shapes  161
drawing shapes  160
formatting images  162
formatting shapes/text boxes  161
formatting text in shapes/text boxes  161
inserting shapes/text boxes  158–160
resizing shapes/text boxes  161

online templates, creating workbooks from  9
organization of book  viii
orientation of cell entries  80–81
orientation of pages, changing  31
outlining data  95–97
overflow in cells  2

P
Page Break Preview view  41
page footers/headers, activating area  33
Page Layout view  41
page margins, changing  30
page orientation, changing  31
page setup, modifying  30
paper size  31
paste options  71–72
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pasting

pasting
cell formatting without content  74–75
cell values without formulas  74
data  71–72
formats  73
values  73

PDF (.pdf) format  51, 53
percentages, displaying numbers as  86
percentages in calculations  124
personal information, inspecting workbooks 

for  56
pictures  163–164
pie charts  145
plotting chart data  148–150
Portable Document Format  51, 53
practice files  viii–ix
pre-addressed email messages, creating 

through hyperlinks  23
prerequisites, exam  2–4
previewing imported data  13
print area  49
print scaling  54
printing

defining selected range for  49
portion of worksheet  48
sheet elements  54
supporting content  55
worksheets  48

procedures, adapting steps  x
PROPER() function  137–138, 141
properties

changing basic  46
displaying  46
inspecting workbooks for  56
modifying document  45–46
moving to locations with specific  17

Q
Quick Access Toolbar  38–41
Quick Analysis tool  146

R
radar charts  145
ranges, finding  17
reference operators in calculation  124
references  See formulas

relative references  120–121
See also formulas

renaming worksheets  25
reordering

commands on Quick Access Toolbar  40
worksheets  11

replacing data  76–77
resizing

charts  156
shapes/text boxes  161

reusing data  71–75
ribbon, collapsed groups  x
RIGHT() function  137, 140
rows

See also table rows
changing height of  27
deleting  27
finding hidden  37
freezing/unfreezing  44
hiding/unhiding  36–37
horizontal/vertical alignment  80
inserting  27
managing, overview  26
selecting  2
selecting data in  2
sizing to fit content  28
text wrapping in  80
transposing  75

row titles, displaying repeating  56

S
Save As dialog box, opening  52
saving

files in alternative formats with default 
settings  52

files in PDF or XPS format  53
workbooks in alternative formats  50–51

scaling  54
scatter charts  145
searching

for data within workbooks  15–16
for formatting  16
for hidden columns/rows  37
for text  15

series
applying custom  70
creating custom fill  69
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treemap charts

filling date, day, or numeric  68–69
setting advanced options for data  69

series axis  150, 152
series types  67–68
shapes  158–161
sheet elements, printing  54
Single File Web Page format  50
sparklines

changing type of  95
creating  93
deleting  95
enhancing  95

split windows  45
splitting workbooks  44–45
Start screen  8
start_num argument in functions  138
stock charts  145
styles

See also table styles
applying to cells  84
applying to charts  156

subtotals, creating within data ranges  96
SUM() function  125–127
SUMIF()/SUMIFS() functions  132
summary rows, calculating  96
sunburst charts  145
supporting content, printing  55
surface charts  145
switching views  41–42

T
table columns

See also tables
deleting  106
filtering by  114
filtering to match entries in  115
inserting  104
moving within tables  105
sorting by  114

table rows
See also tables
deleting  106
enabling functionality in  110
inserting  104
moving within tables  105
removing duplicates  117–118

table styles  108–110
See also tables

tables
See also table columns; table rows; table 

styles
applying contrasting formatting to 

elements  111
calculation row, adding  110
changing names of  103–104
changing sort order  115
clearing formatting from  109
configuring Total row function  111
converting from data ranges  102–103
converting to cell ranges  106
creating  103
creating from cell ranges  100–101
filter buttons, displaying/hiding  110
filtering  110, 114–117
formatting  100–103
header rows  109–110
naming  100–101
number filters  116
removing duplicate rows from  117–118
removing filters  116
selecting  103
selecting columns/rows  2
sorting  114–115
text filters  116
total row  109

templates  8–10
text

adding to shapes  161
alternative, displaying for hyperlinks  23
copying to adjacent cells  70
filtering in tables  116
formatting by using functions  137–140
modifying by using functions  137–140
searching for  15
sizing columns/rows to fit  28

text argument in functions  137–138
text boxes  158–161
text (.txt) files, importing data from  13
text wrapping in cells  80–81
themes, applying to workbooks  30
top/bottom formatting rule  90
Total row  109, 111
transposing cells  73, 75
treemap charts  145
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unfreezing columns/rows

deleting  3
displaying formulas in  43
displaying hidden  37
displaying repeating column/row titles  56
displaying standard view  42
finding data within  15
finding hidden columns/rows  37
freezing columns/rows  44
hiding  37
importing files to  13
inserting pictures on  163
inserting text boxes on  160
linking to in workbooks  22
modifying display of  41–44
moving  11
moving pictures on  163
Normal view  41
Page Break Preview view  41
Page Layout view  41
plotting data as charts  148
printing  48
printing elements of  54
renaming  25
reordering  11
scaling when printing  54
selecting all content  2
selecting columns/rows in  2
switching views in  41–42
unhiding columns/rows  37

wrapping long entries in cells  81

X
x-axis  152
XML Paper Specification  See XPS (.xps) format
XPS (.xps) format  51, 53
X Y (scatter) charts  145

Y
y-axis  152

Z
z-axis  152
zoom level  42–43

U
unfreezing columns/rows  44
unhiding columns/rows/worksheets  37
UPPER() function  137–138, 140

V
value axis  152
values, pasting  73
views  41–42

W
waterfall charts  145
webpages, creating hyperlinks to  19
width of columns, changing  28
windows  45
workbook elements, finding  17
workbooks  19

adding worksheets to  10
applying themes to  30
changing appearance of content  29
commands for working with  5–6
copying worksheets  11–12
creating and linking to  19
creating blank  9
creating custom Quick Access Toolbar for  41
creating from templates  9–10
displaying multiple parts in window  43–44
displaying multiple views of in separate 

windows  45
finding data within  15
formats  50–51
inspecting  56–60
linking within  22
moving to elements of  17
moving worksheets  11
printing all populated worksheets in  48
reordering worksheets in  11
saving in alternative formats  50–51
splitting  44, 44–45

worksheets
activating page footer/header area of  33
adding to workbooks  10
changing color of tabs  25
copying  11–12
copying pictures to new locations  164
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